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Sobre Print To Me  
Print To Me permite a los usuarios imprimir documentos desde una PC a cualquier MFP 
Ricoh en lugar de imprimir en una impresora o MFP predeterminada. MFP 
constantemente están siendo utilizados por otros empleados, o pueden no estar 
disponibles debido a los atascos de papel, la falta de suministros, o mal funcionamiento. 
Imprimir documentos a Print To Me permite a los usuarios acceder a ellos desde 
cualquier MFP en la red, por lo tanto, si un MFP no está disponible, los usuarios pueden 
visitar el siguiente sin reimprimir el documento o tener que preocuparse de privacidad.  
También emplea la autenticación LDAP para un entorno de impresión segura. Usuarios 
con cable e inalámbricos se beneficiarán de tener una sola impresora  (Print To Me) 
instalada en sus equipos mientras se les da la flexibilidad para recuperar sus 
documentos impresos de cualquier MOST activo dispositivo Ricoh. 

Flujo de Trabajo con Print To Me 

 Usuario imprime un documento a Print To Me a través de un controlador de 
impresión estándar. 

 El software Print To Me reconoce el nombre de usuario, equipo y documentos 
que se imprime. Toda esta información se almacena en el servidor MOST.  

 El usuario puede ir a cualquier MFP en la red, iniciar sesión en MOST e imprimir 
sus documentos.  

 MOST identifica al usuario y enlista los documentos del usuario en la pantalla de 
MFP.  Los usuarios, a continuación, pueden solicitar el trabajo de impresión, pre 
visualizar el trabajo de impresión o eliminarlo   

 El usuario puede seleccionar el documento o documentos necesarios e 
imprimirlos directamente al MFP. También tienen la capacidad de eliminar el 
documento después de la impresión 

 Todas las solicitudes de inicio de sesión y comunicación entre el MFP y el 
servidor MOST son encriptados usando 1024 bits de cifrado de claves de RSA.  

Requisitos del Sistema 
 Reform 12 Enterprise o Reform 12 PDC 

 Plugin MOST 

 Plugin Print To Me  

 Para evaluación y demostración: Windows XP, Windows 2003 Server, Windows 
Vista, Windows 7 o Windows Server 2008 (se admiten los sistemas operativos de 64 
bits) 

 Para los sistemas de producción: Windows Server 2003 o Windows Server 2008 
(sistemas operativos de 64 bits son compatibles) 

Todas las descargas de software Reform necesario pueden encontrarse en 
www.fabsoft.com >> Sección de descargas. 

http://www.fabsoft.com/
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Requisitos de Hardware 
Consulte la documentación de Reform 12 y documentación MOST acerca de los 
requisitos de Hardware.   

Requisitos Previos 
1. Asegúrese que Reform y MOST estén instalada y funcionando correctamente 

con sus MFPs de Ricoh. Debería poder iniciar sesión desde el MFP 
correctamente, si no, por favor consulte la Guía de instalación y configuración 
de MOST. 

 

2. El Servidor MOST Server debe estar en el mismo dominio que el servidor de 
Active Directory. 

 

3. Habilitar LDAP en el administrador MOST (MOST Manager).  Esta configuración 
se encuentra en el MOST Manager yendo a Edit >> Settings y navegando a la 
pestaña Authentication. Especifique un dominio si se está utilizando el tipo de 
servidor de Active Directory.  Para obtener más información acerca de la  
pestaña de autenticación consulte el Manual MOST. Los usuarios podrán acceder 
a MOST en el MFP utilizando su nombre de usuario LDAP de Active Directory. 

 

Instalación 
Para instalar Print To Me a su instalación existente de Reform 12, debe descargar y 
ejecutar el ejecutable de instalación Print To Me. 
 

 
 

Siga paso a paso las indicaciones hasta que comience la instalación. Permita la 
instalación Print To Me completarse. 
 
El directorio de instalación predeterminado para Reform 12 y sus plugins es 
C:\Program Files\Reform…\.  Si ha cambiado la ruta durante la rutina de instalación 
Reform, o si utiliza un sistema operativo de 64 bits, consulte la ruta adecuada en lugar 
del predeterminado al que hace referencia a lo largo de esta documentación.  

Plugin de Registro y Licencia 
Al evaluar Reform 12, los plugins también estarán en un modo de evaluación para ese 
período de tiempo.  Una vez que Reform ha sido comprado y con licencia, los plugins 
necesarios deben estar licensiados para continuar funcionando correctamente.    
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Consulte la sección "Reform 12 licencias y registro” en el Manual de Usuario Reform 12 
para más información acerca de cómo poner licencias a los Plug-ins  de Reform 12.  
Después de introducir la licencia, el Reform Spooler deberá reiniciarse para actualizar las 
licencias. Puede encontrarse más información sobre el servicio Reform Spooler en el 
Manual de usuario Reform 12. 
 

Instalar el PrintToMe Remote Software: 

Seleccionar Start\Reform\Print_To_Me\PrintToMe Remote Deployment Tool para  
instalar PrintToMe Remote. 
 

Seleccionar PrintToMe Remote de la lista desplegable y haga click en Next. 
  

 
 
En la pestaña Credentials rellenar el nombre de usuario, contraseña y dominio. Nota: 
Debe usar una cuenta administrativa, preferentemente la misma cuenta que utiliza para 
ejecutar sus servicios. Haga click en el botón Verify Credentials y después de comprobar 
sus credenciales, haga click en Next para ir a la pestaña Configuration.  
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En la pestaña Configuration especifique el Boot Time Out, Process Time Out, 
Simultaneous Installations, y Operating Systems.  Puede dejar como configuración 
predeterminada. 
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Haga click en el botón Client Settings para ver la configuración PrintToMe Remote. Estos 
son los valores que se envían a las estaciones de trabajo.  
 

. 

En la pestaña Target Systems puede especificar sus estaciones de trabajo mediante 
consulta LDAP, CSV o introducir manualmente el nombre del equipo. Haga click en el 
botón LDAP Lookup para mostrar la estructura de LDAP. Puede seleccionar el grupo o el 
sub grupo para mostrar la lista de los equipos dentro del grupo. 
 

 
 
Todos los equipos se seleccionarán de forma predeterminada, puede anular la selección 
haciendo click en la casilla de verificación. Para propósitos demo o sólo una de las 
estaciones de trabajo será seleccionada, PrintServer1. 
 



 Print To Me For MOST  8 
 

                                                                          Print To Me 

 
 

Haga click en el botón Get Status para comprobar el estado del paquete que intenta 
instalar en este caso estamos buscando PrintToMe. Verá en la columna Status column 
que PrintToMe no está instalado en PrintServer1. 
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Haga click en Next para ir a la pestaña Begin Installations. Ir a la pestaña Not Installed 
para ver el sistema en el cual queremos instalar PrintToMe. Haga click en Install para 
iniciar la instalación.   

 
 

PrintToMe está siendo instalado. 
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Se le llevará a la pestaña de Resultados.  En esta pestaña verá las siguientes fichas de 
Estado: Active, Successful, y Failed.  En la pestaña Successful puede ver aquí que hemos 
implementado con éxito PrintToMe en PrintServer1. 
 

 
 

Importación Pantallas MOST  
Por favor consulte el manual MOST para obtener más información sobre la terminología 
de MOST,  Configuración MOST y prueba de conexión. 
http://fabsoft.com/Downloads/ReformEnt12/MOST/Reform12_MOST.pdf. 
 

Para importar Pantallas MOST ir a Start> Programs> Reform…> Print_To_Me> Install 
Screen to MOST Designer.   
 

 
 

Configuración de  Global Variables 
Tenemos que configurar la comunicación entre MOST y PrintToMe.  Para ello, tenemos 
que configurar ciertos parámetros de pantalla de MOST’s Global Variables.   Si el MOST 
Designer no está abierto aún, ir a Start>Programs> Reform… >MOST>Designer. 
 
Ir a Data>Global Variables 
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Hay una sola variable global de PrintToMe que es capaz de configurar.  PrintAllJobs y 
DeletePrintJobs también están relacionados con Print To Me pero siempre deben ser 
True.  Por favor consulte la nota a continuación para obtener más información. 
Seleccione la variable, elija una de las opciones disponibles en la lista desplegable y, a 
continuación, haga clic en el botón Update.  
 

1. Variable Name =CommunicationType  Value= Local 
 

*CommunicationType especifica si el MFP es accesible por IP desde el servidor MOST.  
Si el MFP es alcanzable por el IP del servidor de MOST, el CommunicationType debe 
establecerse como “Local”.  Si el MFP es en una red remota (área amplia),  el 
CommunicationType debe establecerse como “Remote”. 
 

 
 

Haga click en  File>Save o utilice el icono pequeño de guardar  para guardar todas las 
Variables Global. 
 

Asignación de colección para los Usuarios 
 

1. Ir a Start>Programs>Reform…>MOST>Designer 
2. En la barra de herramientas de MOST Designer haga click en Data>Users and 

Groups 
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3. Haga click en Add.  
 

 
 

4. Tendrá que agregar un nombre de usuario de Active Directory o el grupo como el 
que va a iniciar sesión. 
 

 
 

5. Para la demostración, utilizaremos el grupo LDAP Domain Users 
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6. Resalte su nombre de usuario o grupo y seleccione Print To Me del cuadro 

Available Collections y haga click en    para agregar PrintToMe. Sugerencia: 
Establecer Login Timeout to 0 para deshabilitar el tiempo de espera 
automático. 
 

 
 

7. Ir a File>Save o utilice el icono pequeño de guardar  para guardar los cambios. 
 

Configuración MOST para habilitar la impresión remota de 
documentos en el MFP 
 

*Si se establece la variable global CommunicationType en Local (MFP puede ser 
alcanzado por IP en una red local), puede omitir este paso.  Para imprimir documentos 
de forma remota (cuando un MFP no es alcanzado por IP), el CommunicationType 
debe establecerse en remoto y las siguientes medidas se deben tomar. 
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Remote Printing debe estar habilitada en el MOST Manager si el CommunicationType 
ise establece en Remote en la configuración de las Variables Globales.   
 

1. Para ello, primero compruebe que MOST Manager está abierto yendo a 
Start>Programs>Reform…>MOST>Manager.  Puede estar ejecutandose en su 

barra de tareas, así que compruebe el icono pequeño  icon y haga doble click 
en él para que aparezca la MOST Manager. 
 

 
 

2. Ir a Edit > Settings 
 

 
 

3. Ir a la pestania Devices. Aquí tenemos que chequear la casilla de verificación 
Enable Remote Print si no está ya seleccionada.  También debe especificar el 
directorio de cola de la instalación de Reform, que suele ser C:\Program 

Files\Reform…\Queue.  Utilice el botón Examinar   para seleccionar este 
directorio.  El intervalo de sondeo es la frecuencia con la que el MFP comprobará 
este directorio para trabajos de impresión.  Si 30 segundos no es óptimo para su 
entorno, por favor cambiar al valor deseado. 
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Nota: Cuanto menor sea el intervalo, se producirá más tráfico de red y 
comunicaciones. 

 
 

4. Una vez finalizada la configuración de impresión remota, haga click en el botón 
Save.  Se le solicitará que reinicie el servidor, haga click en OK. 

 

 
 
Ha configurado correctamente MOST para habilitar la impresión remota de documentos 
en el MFP. 

 

Cómo configurar el controlador PrintToMe 
Ir a Start > Control Panel > Hardware > Devices and Printers.  Haga click derecho en el 
controlador PrintToMe. Seleccionar Printer properties. 
 

 
El controlador PrintToMe empezará la actualización. 
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En la ventana PrintToMe Properties.  

1. Haga click en la pestaña Accessories . En la barra de desplazamiento, seleccione 
Generic Model. 

 

 
 

2. Haga click en Update Now.  
 

 
 

3. Después de hacer la actualización, compruebe las tres opciones anteriores. Haga 
click en OK. 
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Tutorial PrintToMe 
En este tutorial se muestran cómo utilizar el controlador de impresión de Print To Me 
para enviar trabajos a un MFP.  Todos los documentos que el usuario imprime se 
almacenarán en el servidor de MOST Server y aparecen en las dos pestañas Print To Me. 
En ese punto, el documento o documentos que desee se pueden imprimir directamente 
al MFP.  Para ver los documentos impresos, estos pasos deben llevarse a cabo en un 
MFP real y no el emulador MFP (MOST Desktop).  
 

1. La rutina de instalación agrega automáticamente una impresora llamada Print To 
Me y se comparte para que las computadoras (estaciones de trabajo) pueden 
conectarse a ella.  Para enviar un trabajo de impresión al servidor MOST y tener 
acceso a ella en el MFP, los usuarios imprimen como lo harían normalmente, 
pero en lugar de seleccionar una impresora específica, deben seleccionar la 
impresora PrintToMe. 

 

 
 

2. Para poder utilizar Print to Me, a impresora primero debe instalarse en un 
equipo que está en el mismo dominio que el  servidor MOST y el servidor Active 
Directory.  Inicie una sesión en una PC con el mismo nombre de usuario que va a 
utilizar para iniciar sesión en MOST en el MFP.  Estos dos nombres de usuarios 
deben coincidir ya que sólo los documentos impresos por el usuario estarán 
disponibles cuando el usuario inicie sesión en el MFP. 
 

3. Para instalar la impresora en la PC, Ir a Start > Run escriba la \\<MOST Server 
Name or IP> y presione OK. Reemplazar el <MOST Server Name> con el nombre 
de su servidor ejemplo \\mymostserver.  Esto abrirá las capetas compartidas por 

file://mymostserver
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defecto para ese servidor.  El controlador de PrintToMe aparece como PrintToM 
para adherirse a las limitaciones de Windows 3.x/DOS. 

 

 
 

4. Haga doble click en la impresora “PrintToMe” e instalará automáticamente en tu 
PC. Para confirmar la instalación, vaya a Printers and Faxes en el Panel de 
Control Panel para ver la impresora recién instalada. 
 

5. Imprimir un documento a esta impresora PrintToMe desde cualquier aplicación. 
Para la demostración, utilizaremos la aplicación de Windows “Notepad” con 
algún texto de muestra. 
 

 
 
 

6. Inicie sesión en el MFP y se mostrará el documento en la pantalla Print To Me. 
Hay dos pestañas PrintToMe en su colección PrintToMe.  Esto es para ofrecer 
una variedad de opciones durante la impresión. Puede utilizar cualquiera de las 
dos.  Vamos a proceder con la primera pestaña. Aquí puede ver el documento en 
la columna “Document Name” y la fecha en que fue enviado a PrintToMe en la 
columna “Submitted”.  El botón  Preview puede utilizarse para obtener una vista 
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previa de los documentos impresos (debe seleccionar el documento antes de 
hacer click en Preview). 

 

 
 

7. Haga click en el campo bajo “Print To Me Job Settings:” qué actualmente 
muestra Print and Delete Selected Documents.  Esto le pedirá todas la 
impresión disponibles y/o eliminar opciones 
 

 
 

8. El valor predeterminado es “Print and Delete Selected Documents”.  Elija esta 
opción o cualquiera de los otros valores de impresión. Haga click en OK. 
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9. Ahora seleccione el documento de la lista para que aparezca con un fondo 
negro. Si hay varios documentos, podría haberlos seleccionado también. Una vez 
seleccionado, haga click en el botón Process.   Esto llevará a cabo todo lo que se 
ha seleccionado en la configuración del trabajo Print To Me. 
 

10. Después de hacer click en el botón Process y si se ha seleccionado una operación 
de impresión, los documentos deben haber sido impresos en el MFP. 

 
Solución de problemas: 

 Asegúrese de que los usuarios tienen derechos para el controlador de impresora 
PrintToMe, haga click derecho sobre el controlador de impresora, seleccione 
propiedades y asegúrese de que los usuarios tengan suficientes derechos de 
seguridad. 

 Asegúrese que el servicio Print To Me Process se esté ejecutando (Consulte la 
sección sobre servicios) y que tiene los permisos correctos. 

 Asegúrese que el servicio PrintToMe se esté ejecutando (Consulte la sección 
sobre servicios) y que tiene los permisos correctos. 

 Asegúrese que el servicio Print To Me Mobile se esté ejecutando (Consulte la 
sección sobre servicios) y que tiene los permisos correctos. 
 

Servicios PrintToMe 
Hay tres servicios asociados con el Plugin Print To Me.  Estos son: PrintToMe, 
RM_PrintToMe_Mobile y RM_PrintToMe_Process.  Para ver estos servicios, ir a Start > 
Programs > Control Panel > Administrative Tools > Services . 
 

 
 



 Print To Me For MOST  21 
 

                                                                          Print To Me 

 
Servicio PrintToMe 
Este servicio es responsable de la primera etapa del proceso de PrintToMe. Supervisa los 
trabajos que se envían al controlador de impresora PrintToMe. Su primera tarea es 
capturar el trabajo de impresión para que puede imprimirse más tarde en un MFP. 
También actualiza la base de datos con información sobre el trabajo de impresión, como 
el usuario que imprime, cuando fue impreso y el título del documento.   
 
Servicio PrintToME Mobile 
El servicio móvil de PrintToMe se utiliza para supervisar la bandeja de entrada de una 
dirección de correo electrónico entrante mediante el protocolo IMAP. Cuando se 
encuentra un nuevo correo electrónico, la aplicación descarga los archivos adjuntos y 
recupera la información del remitente.  Si está habilitado el LDAP, el servicio intentará 
consultar información del usuario basada en la dirección de correo electrónico del 
remitente. Luego se imprimirá los archivos adjuntos compatibles con el controlador 
PrintToMe.  El proceso típico de PrintToMe, a continuación, almacena el archivo de 
impresión listo para ser lanzado en un MFP de cuenta del remitente. Si no está 
habilitado LDAP, PrintToMe puede configurarse para enviar una respuesta por correo 
electrónico al remitente incluyendo un código pin que puede utilizarse para liberar el 
trabajo de impresión en el MFP. 
 
Servicio PrintToMe Process  
This service is responsible for the communication between the MOST server running the 
service and the MFP.  When a user selects a document to be printed and or deleted at 
the MFP, the MFP notifies the PrintToMe Process that the selected task should be 
carried out. The PrintToMe Process does the actual printing and or deleting of the 
documents when requested by the MFP. 
 
Log On Accounts 
Dependiendo de su entorno, estos servicios pueden requerir una cuenta de dominio con 
privilegios administrativos en el equipo local y también necesita tener acceso a la base 
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de datos. Para establecer una cuenta de inicio de sesión para un servicio, haga click con 
el botón derecho sobre el servicio deseado y vaya a Properties   
 

 
 

Ir a la pestaña Log On. 
 

 
 
Aquí es necesario rellenar los campos “This Account” que darán el acceso administrativo 
al servicio. Puede utilizar el botón Browse para ayudarle a localizar la cuenta deseada. 
Después de seleccionar la cuenta, introduzca la Contraseña asociada.  Haga click en OK 
una vez completa.  Se le pedirá que reinicie el servicio para que los cambios surtan 
efecto. Para ello, haga click con el botón derecho en el servicio y seleccione Restart, o 
simplemente detener e iniciar el servicio. 
 

Print To Me Móvil 
Print To Me Móvil permite a los usuarios imprimir documentos desde un dispositivo 
móvil en cualquier MFP Ricoh.. Flujo de trabajo Print To Me Móvil: 



 Print To Me For MOST  23 
 

                                                                          Print To Me 

 
o El usuario envía un PDF (u otro tipo de archivo compatible) como datos 

adjuntos de correo electrónico a una dirección de correo electrónico 
especificada, dedicada. (Ejemplo: PrintToMe@FabSoft.com) 

o El servicio móvil de PrintToMe supervisa la bandeja de entrada de las 
cuentas de correo electrónico para los mensajes entrantes. Cuando se 
encuentra un nuevo mensaje, se descarga el archivo adjunto e imprime al 
controlador de impresora designada en el servidor de Reform. Suele ser 
el controlador de impresora PrintToMe.  

o Si LDAP está en uso, el servicio también realizará consultas para obtener 
información del usuario basada en la dirección de correo electrónico del 
remitente. 

 Si la cuenta del usuario se encuentra, el documento 
automáticamente estará disponible para el usuario al iniciar 
sesión en MOST. 

 Si no se encuentra la cuenta de usuario, se envía un correo 
electrónico a su dirección de correo electrónico con un código pin 
que puede utilizarse para recuperar su documento. Para iniciar 
sesión en MOST, el usuario debe introducir el código pin como su 
nombre de usuario y sin contraseña. 

o El software de PrintToMe, a continuación, recibe la información desde el 
controlador de impresora y lo procesa normalmente. 

o El usuario puede entonces iniciar una sesión en MOST en el MFP y 
recuperar su trabajo de impresión. 

Configurando PrintToMe Móvil 

Para utilizar la impresión Print To Me Móvil, primero debe configurar correctamente 
PrintToMe predeterminado.  A continuación, continúe con los pasos a continuación para 
configurar el software para controlar la dirección de correo electrónico dedicado para 
archivos adjuntos entrantes. 
 
Para iniciar la configuración de PrintToMe móvil vaya a Start > Programs > Reform > 
Print_To_Me > Print To Me Mobile Configuration. 
 

mailto:PrintToMe@FabSoft.com
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Se abrirá el cuadro de diálogo de configuración para la configuración. 
 

1. Introduzca la información de IMAP para su servidor de correo electrónico y 
cuenta en la utilidad.   

IMPORTANTE: Debe ser una cuenta dedicada. La cuenta de correo electrónico 
especificada aquí será supervisada por Print To Me Móvil. Cuando Print To Me Móvil 
supervisa el buzón, procesará y ELIMINA todos los correos entrantes. Si esto es 
apuntado por accidente a una cuenta personal, se perderán todos los correos 
electrónicos.     

 
2. Si se requiere un servidor proxy para conectarse al servidor, por favor incluya 

también esa información. Una vez configurado la configuración, haga click en 
“Test IMAP Settings” en la parte inferior de la pantalla para comprobar que la 
conexión es correcta.  
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3. A continuación, se debe configurar la configuración Outbound Email. Estos 
valores se utilizan para enviar un código pin para el usuario si la dirección de 
correo electrónico del usuario no se encuentra dentro de LDAP. Haga click en el 
botón  “Test Settings” para enviar un mensaje de prueba desde la dirección de 
correo electrónico especificada a sí mismo para verificar que fue un éxito.  

a. Nota: El plug-in de correo Reform debe ser configurado y en ejecución 
para las notificaciones de envío 

 
4. La configuración de LDAP puede configurarse para ser idéntico a MOST, o puede 

tener configuración personalizada.  Normalmente, estos deben utilizar la misma 
configuración que MOST. De forma predeterminada, el Mail Object es “mail” y el 
User Object es “sAMAccountName”. 
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5. Los otros parámetros permiten configurar el controlador de impresora al cual 
documentos Print To Me móvil serán impresos. Se debe establecer el 
controlador Print To Me Aquí, también puede especificar la frecuencia con que 
comprobar el servidor IMAP para elementos nuevos en la bandeja de entrada.  
 

6. Si desea poder enviar documentos de word desde tu dispositivo móvil a un MFP, 
Descargar OpenOffice de http://www.openoffice.org. A continuación, haga click 
en el botón “…”para seleccionar el archivo "soffice.exe" de la instalación de 
Open Office. La ubicación predeterminada en un sistema operativo de 32 bits es: 
“C:\Program Files\OpenOffice.org 3\program\soffice.exe”. 

 
 
Haga click en OK para guardar su configuración. 
 

 
 

 

http://www.openoffice.org/
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                                                                          Print To Me 

Si no se ha ejecutado el servicio PrintToMe Mobile un mensaje aparecerá preguntando 
si desea iniciarlo. Haga click en Yes para iniciar automáticamente el servicio. 
 

 
 
Print To Me Móvil ahora está configurado y listo para utilizarse. 
 
Con el fin de que PrintToMe Móvil funcione correctamente con Open Office asegúrese 
que la cuenta de servicio Print To Me Móvil  este establecida como administrador local 
en la computadora (cuentas de sistema Local y servicio de red no funcionarán 
correctamente). A continuación, conectarse en la computadora con la cuenta de servicio 
especificado e Inicie Open Office manualmente. Tendrá que pasar por la pantalla de 
registro rápido antes de que se pueda ejecutar la aplicación. Una vez hecho esto, se 
pueden enviar documentos de Word a través de Print To Me Móvil. 
 
 

Mantenimiento 
Hay ciertos directorios y tablas SQL que deben controlarse para crecimiento, junto con 
el plugin Email para Reform 12.  Cada vez que un sistema procesa más y más trabajos, el 
tamaño de estos directorios y tablas SQL puede crecer muy rápidamente. En general el 
rendimiento del sistema puede verse afectado por la gran cantidad de espacio que 
pueden ocupar los archivos.  Además, existe un límite de base de datos de 4 GB si utiliza 
Microsoft SQL Server Express 2005 suministrado con la instalación. Entradas obsoletas 
archivos/base de datos se deben eliminar de acuerdo a sus necesidades y 
especificaciones de retención de archivos. Se recomienda monitorear el crecimiento de 
los siguientes directorios y tablas SQL: 
 
Directorios: 
C:\Program Files\Reform…\Queue\Print_To_Me 
C:\Program Files\Reform…\Plugins\Print_To_Me\Mobile 
 
Tablas SQL: 
PrintToMe 
 
 
 
Otros nombres de empresas o productos mencionados en este documento pueden ser 

marcas comerciales o marcas registradas de sus respectivas empresas 


